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LICENSE AGREEMENT
By installing this software, you acknowledge you have read and agree to the terms and conditions of the 
User's License Agreement outlined below.    If you do not agree, do not install this software.    

Equivision™ provides this Program and User's License to you under special terms and conditions.    In 
consideration of your purchase fee, Equivision™ as the Licenser, grants to you, the Licensee, a non-
exclusive right to use the enclosed software and accompanying images. You assume full responsibility for
the purchase of this license, as well as the installation, the use of, and the results obtained from the 
software. This license authorizes you to install and use one (1) copy of this software and images on one 
(1) single computer only. This program and its contents are owned and copyright protected by 
Equivision™.    Illegal reproduction, distribution or sale of this software and accompanying images is a 
Federal Crime and strictly prohibited.      



OVERVIEW
The EquiGraphics Plus™ Version 2.1 for Windows contains a built-in image viewer, clipart, color photos 
and web-ready images. Over 500 images total.

The installation setup program installs only the EquiGraphics™ image viewer application to the C:\
Equiplus directory of your hard drive. The images do not become installed, (there are over 600 
Megabytes of images) so they remain stored on your CD ROM permanently. This is standard industry 
practice and saves you precious hard-drive space.    Consequently, once the application is installed, you 
must insert your EquiGraphics Plus™ CD into your CD ROM drive, then start the EquiGraphics™ 
application in order to view or use the images.

The images contained in EquiGraphics Plus™ are stored as standard industry formats and are 
compatible with virtually all desktop publishing, page layout, and word processing programs. For greater 
versatility, we have engineered the EquiGraphics™ viewer to recognize a variety of different graphic file 
formats so you can also use it to view images in other directories in your computer as well. 

For detailed instructions on image usage and editing, please read the appropriate topics contained in this 
help menu.



ANTI-ALIASING
This option takes a 2 color document and converts it to gray scale when the display resolution is less than
the resolution of the image.



AUTO-RUN INSTALLATION
This CD-ROM contains an installation panel that will display automatically once the EquiGraphics Plus™ 
CD is inserted into your CD ROM drive. To begin the installation, simply click on the "Run Set-Up" button. 
If the installation panel does not display automatically, it means that your Windows operating system has 
the "Auto-Run" feature disabled.    You then have two options to install the program: 

Option 1: Start the CD ROM manually.
Go to your Windows Desktop, click on "Start", then "Run" , then type in: D:\autorun.exe    then click OK.    
(D refers to your CD ROM drive letter, please substitute your actual drive letter if different. 

Option 2: Activate the "Auto-Run" feature in your system. 
Go to "My Computer", then select "Control Panel" then select "System". On the System Properties Panel, 
select "Device Manager", then double click on the CD ROM icon to show your CD- ROM device. Double 
click on the CD-ROM device to bring up the "Properties Panel." Select the "Settings" tab, then select the 
"Auto Insert Notification" so that a check mark appears in the small box next to it, then click OK or Apply. 
Some systems may require that you restart your computer for the changes to take effect.



BMP
This graphics file format (Bitmap) was created by Microsoft and is primarily a Windows™ format.    BMP 
files may or may not be compressed.    Non-compressed BMP files load and display very quickly, but take 
up a large amount of disk space, while compressed BMP files take up less disk space, but usually take 
longer to decompress.



BROWSE THROUGH FOLDERS
The image viewer supports browsing through all image folders on a disk drive. In the Folders Window, 
double-click on a folder to display the images in that folder. The images in the folder will display in the 
Images Window, and the file names will appear in the File List.



COPY OR IMPORT IMAGE
Once you have identified an image for usage, simply click on it to bring it to full size. Next, click on it with 
your "Right" mouse button to bring up the "Options Panel".    

Select the "Copy" option by clicking on it with your normal "Left" mouse button. This will copy the image 
to the "Windows™ clipboard.    Next,    shut down the EquiGraphics™ application and open your desktop 
publishing, page layout, or word processing program of choice.    Go to a new document, or an existing 
document that you want to copy the image to. Once the correct document is open, select the "Edit" menu 
at the top left of the application screen, then select the "Paste" option.    This will place the image into your
active document. Usually, depending on the application, you will see "handles" on the image. You can 
enlarge or reduce the size of the image by clicking on the image to activate the handles, and then by 
dragging the handles with your mouse.

If you have not copied an image to your Windows clipboard, you may want to use the "Insert"    option in 
your application of choice to "Import" the image. Simply go to the "Insert" menu located at the top left of 
your desktop publishing, page layout, or word processing program. Select the "Image" and/or "Picture" 
option (which ever is appropriate for your application) and make sure the EquiGraphics Plus™ CD is in 
the CD ROM drive.    

When prompted, select your correct drive letter to activate the EquiGraphics Plus™ CD ROM.    Typically, 
this will show a drive icon with a small CD, and the word "Equiplus" next to it. 

Select that drive, then double click on the "Equiplus" folder to bring up the three (3) image folders; Clipart,
Photos, and Web. Double click on the image directory you want to browse, then scroll the list of image file
names to find the image you want to import. Select the image, then select "OK" to import the image into 
your document.

If you experience difficulty importing an image, please call the manufacturer of the application you are 
using, or read their user-guide instructions on how to use their import/insert function.

Hint: Copying an image to the Windows™ clipboard from within the EquiGraphics™ application, and then
pasting it into your active document, is a much simpler way to add the image to your document.



DCX 
This format is a variation of the 2 color PCX format.    A DCX file is little more then a multiple image 2 color
PCX file.



DITHERING
Dithering is a method of rendering a large number of colors when the display contains a limited number of
colors.    Dithering enhances the image to the human eye.



FIT TO SIDES
This option will adjust an image so that it completely fills the horizontal dimension of its window, while 
maintaining the correct aspect ratio for that image.    Depending on the dimensions of the image, vertical 
scroll bars will appear so that the image can be scrolled up or down.



FIT TO HEIGHT
This option will adjust an image so that it completely fills the vertical dimension of its window, while 
maintaining the correct aspect ratio for that image.    Depending on the dimensions of the image, 
horizontal scroll bars will appear so that the image can be scrolled left and right.



GROW TO FIT
This option will adjust an image so that it completely fits in its window while maintaining the correct aspect
ratio for that image.    Depending on the dimensions of the image, the horizontal or vertical parts of the 
image will be clipped so that the image completely fits in the window.



IMAGE EDITING OPTIONS
The EquiGraphics™ viewer application contains some basic image editing options that are accessible 
through the "Options Panel".

Once you have identified an image that you want to use or edit, simply click on it to make it full size. Next,
click on it with your "Right" mouse button to bring up the "Options Panel".    Use your "Left" mouse button
to select options in the "Options Panel". From within the options panel,    you can edit the image by 
making the desired selections. Once you have completed editing, you can select the "Copy" option to 
copy the image to the Windows™ clipboard. You can then "Paste" the image to your desktop publishing, 
page layout, or word processing program of choice, while preserving the changes you made. The original 
image that is stored on the CD will remain unchanged. 

The various editing options are detailed individually in this help menu.



IMAGE FILE FORMATS
The current version of EquiGraphics™ for windows supports PCX, DCX, BMP, PIC, TIFF, GIF and JPEG 
file formats.

The viewer does not compress images, but it does de-compress images that have been previously 
compressed so that you may be able to view and use them. 



IMAGE PRINTING
You cannot print an image directly from the EquiGraphics™ viewer screen.    You can only print the image 
by placing it into another application that contains a printing option such as your desktop publishing, page 
layout, or word processing program. 

Once you identify an image for use in a layout, simply copy it to your application of choice. You can also 
open your application of choice and then import the desired image.    Once the image is placed into your 
application document, simply select the "Print" option for that application.    Please remember that the 
quality of the printed image will depend on the quality of your printer and its default settings, as well as the
settings on your application of choice.

For detailed instructions on the copy or import function, please read the "Copy or Import Image" section of
this help menu. 



IMAGE VIEWING 
Whenever you want to view images, simply insert your EquiGraphics Plus™ CD into your CD-ROM drive, 
then go to your Windows Start Menu, select Programs, then select the EquiGraphics Plus™ icon. 

Once the EquiGraphics™ viewer screen comes up, you can select the minimize or maximize option by 
clicking on the "double rectangle" icon at the top right of the screen next to the "X" icon. This will give you
a full size or partial size viewer screen.

Once you are comfortable with the screen setting, go to the top left of the viewer screen to select your CD
ROM drive. Select the "down" arrow to show the list of drives on your computer, then select your CD 
ROM drive that contains the EquiGraphics Plus™ CD. Typically, this will show a drive icon with a small 
CD, and the word "Equiplus" next to it. Select that drive, then double click on the "Equiplus™" folder to 
bring up the three (3) image folders, Clipart, Photos, and Web.    Simply double-click on the image folder 
you want to view. To browse another folder, simply double click on the Equiplus™ folder again to bring up 
your three image folder options, then make your selection.

Once you are in your image folder of choice, you can view images in full size or thumbnail groups of 10 or
22 images. To set the thumbnail group option, go to the "Window" menu located at top left of the 
EquiGraphics™ viewer screen and make your selection. . 

To view    a thumbnail image at full size, simply click on the thumbnail. Click on it again to revert back to 
the thumbnail size.

When displaying images, the selected image is always highlighted in the File List, and has a "lowered" 
outline around the image.

You navigate through the various image pages in the folders by selecting the "Previous" or "Next" buttons 
located at the bottom of the viewer screen.    

Hint: If your EquiGraphics Plus™ viewer screen comes up blank or shows strange files, it just means you
have not selected your correct CD ROM letter to activate the CD, or you have not double-clicked on the 
Equiplus™ main folder. Once your are in the main Equiplus™ folder, make sure you are selecting the clip-
art, photos or web image folder. Also, please make sure you have inserted the EquiGraphics Plus™ CD 
ROM into your drive.



JPEG 
This file format is an international standard.    It was created by a group known as the Joint Photographic 
Experts Group or JPEG.    It is designed specifically for compressing 24-bit continuous tone images like 
photographs.    The JPEG format is for the most part a "Lossy" format.    A lossy format is one whose 
resulting decompressed image is not an exact duplicate of the original image.    The amount of loss varies 
depending on the quality setting and amount of compression used when the image was originally 
compressed.



MAGNIFYING GLASS TOOL
When viewing the image in full size, press the CTRL key, then click on the image with the left mouse 
button to increase the size, and with the right mouse button to reduce the size. 



MEMORY SAVER MODE
The "Memory Saver" mode maintains only the minimal amount of image information to view the images in
a particular thumbnail viewing mode. This allows you to view and scroll through many thumbnails images 
at one time, without requiring the added memory that is typically required for viewing full size images. The
drawback of this mode is a speed loss when viewing the full size image from a thumbnail. The advantage 
of this mode is that viewing many thumbnails is faster on machines with lesser amounts of memory. This 
is especially helpful when viewing thumbnail images that have very large file sizes. 

To enable the "Memory Saver Mode" , simply go to the File menu at the top left of the EquiGraphics™ 
viewer screen. A check mark on the Memory Saver panel indicates that it has been enabled.



MIRROR
The option causes the image to be mirrored horizontally from left to right, and vertically from top to 
bottom.    This is the same as if the image were rotated 180 degrees on its central vertical axis.    The 
image becomes either a right hand or left hand, and/or top or bottom, of it's former self.



MULTI-IMAGE VIEWING
The EquiGraphics Plus™ Image Viewer can view (1) one, (10) ten, or (20) twenty images at one time. 
Please see the "Image Viewing" section in this help menu for details.



PANNING IMAGE
This option allows you to view parts of an image that are hidden from the screen because the image is 
larger than the screen size can display. Simply press the Shift key and hold it down while clicking on the 
image with your left mouse button to bring up the panning hand icon. Drag the panning hand icon to view 
the hidden parts of the image.



PIC
This file format is a proprietary format created by the Pegasus Imaging Corporation.    It is based on a 
variation of the JPEG format.    One of the advantages to this format is that unlike the JPEG format, the 
PIC format contains a palette which can be used when displaying the image on a 256 color display.    This 
eliminates the time it takes to create a histogram and determine the best palette for the image.



PCX 
This file format was created by ZSoft.    It supports 2, 4, 16, 256 color, and 24 bit color images. Because 
the data is only slightly compressed, the decompression times are usually minimal.



ROTATE
This option allows you to rotate an image to the right, left or upside down (flip).
Image rotation is achieved by re-drawing the image to the desired aspect. Because the image data never 
really moves, you never wait while the image is being rotated.



SCROLL BARS
If this item is checked,    the viewer will cause the image to display scroll bars anytime the image is 
zoomed beyond the confines of its window.    Scroll bars allow the user to view hidden parts of an image 
when it is too large to fit in the window screen. 



SHRINK TO FIT
This option maintains the correct aspect ratio of the image and shrinks the image so that it fits completely 
in its image window, without any truncating or distortion of the original image.    Since the Shrink to Fit 
option preserves the original aspect ratio of the image, there may be empty space left in the image 
window.



STRETCH TO FIT
This option will change the aspect ratio of the image so that the entire image is stretched to fit the exact 
dimensions of it's window. This will distort the original dimensions of the image. 



TECHNICAL HELP
Upon registration you are entitled to 30 days free technical assistance for all issues pertaining to software 
installation difficulty or operating errors. Technical assistance is not provided to unregistered users, so be 
sure to fill out and mail the registration card to Equivision™ .    
You can also register on-line at http://www.equivision.net. 

Tech Help:      Available Monday through Friday only: 11:00 am - 4:00 pm Pacific Standard Time.    Phone: 
(760) 839-2242      Fax: (760) 839-6616        E-Mail: Screenpix1@aol.com

Technical help is strictly for installation difficulty, or operating errors due to CD incompatability or 
malfunction. It is not for learning how to use the application. Please read the appropriate sections in this 
help menu to become familiar with the use of the application. It explains everything you need to know.

Extended Support:    
Users requiring assistance after the initial 30 days free technical assistance period will be charged $ 
15.00 for the first 15 minute time period and $ 10.00 for each subsequent 15 minute period on each call.    
Please have your credit card number ready.



TIFF
This file format was created by Aldus/Adobe.    The images stored as a TIFF file format can be a wide 
variety of sub-formats.    The TIFF specification contains so may variations that writing a TIFF file decoder 
which can decode all TIFF file formats is next to impossible.    Even Aldus/Adobe the original creator of the
TIFF format does not support all of the file formats that have been re-created by other companies.    The 
EquiGraphics™ viewer currently supports uncompressed TIFFimages and TIFF images compressed 
using CCITT 1D, Group 3, Group 4, packed bits, and LZW compressed. It does not support tiled TIFF 
images.



TROUBLE SHOOTING
(1) The installation panel continues to display each time the CD is inserted into the CD ROM drive, even 
though the application is already installed. 

This is due to the user changing the default installation directory during the installation set-up. 
The default directory is C:\equiplus. Please re-install to the default directory without changing any 
of the default values.    

(2)The images do not display on the viewer application screen.
You have not selected your correct CD ROM drive letter or folder that contains the images. 
Please refer to the "Image Viewing" section of this help menu for detailed instructions.



UNINSTALL
To uninstall the EquiGraphics Plus™ application, simply go to "My Computer" select "Control Panel", then
select the "Add/Remove Programs" icon. Select EquiGraphics Plus™ from the application file list, then 
click on the "Add/Remove" button. This will display the uninstall panel. From this panel you can choose 
"Automatic" or "Custom" removal of the program. The custom option allows you to control which files are 
removed. 



USE OF IMAGES AND LEGAL RESTRICTIONS:
The images contained in the CD ROM are the property of Equivision™ and its contributing vendors. The 
images are copyright protected by international law, and can be used by the Licensee on a royalty-free 
basis provided the images are used as part of a total graphic design, such as flyers, brochures, 
newsletters or product packaging. The images cannot be used on any consumer product that will be sold 
either at wholesale or retail whereby the image is considered the integral part of the product sale, such as
a poster, greeting card, tee-shirt, or calendar. When the primary reason for the purchase of a product 
would be due to an image on a product, and that product would lose its salability if the image was omitted,
then the image is considered an integral part of the product and is prohibited from use.

The images can be used for creating web sites only when the image is a part of the actual web site 
design. The Web Master must then include a disclaimer and/or restriction notice that warns and/or 
prevents on-line visitors to the Web-site from unlawfully downloading and using the images that were 
used in the design. 

Under no circumstances can any of the images be included as free content that can be downloaded for 
any web-site promotion, or for bundling purposes with other software, or with any other activity that would 
diminish the value and salability of the CD or its content to future purchasers. 

Equivision™ employees make their living by selling the CD ROM to end users. By unlawfully using and/or
distributing any of the content on the CD ROM, you are directly responsible for depriving Equivision™ 
employees of their income, and you are actually jeopardizing their livelihood.    Violators of our image 
usage and license agreement will be prosecuted to the fullest extent possible under the law. 

Use of these images does not transfer ownership rights, either in whole or in part, to the Licensee. The 
images and accompanying software remain the proprietary content of Equivision™ and it's contributing 
vendors. 



WARRANTY
Equivision™ warrants the CD-ROM disk on which the software and images are furnished to be free from 
defects in workmanship and materials for a period of 30 days from purchase.    Equivision's™ entire 
liability for defective media shall be a replacement disk when the original is returned to Equivision™ with a
proof of purchase receipt. Equivision™ disclaims all other warranties, either expressed or implied, 
including, but not limited to, merchantability and fitness for a particular purpose with respect to the 
software and images. Equivision™ does not warrant the software and images will meet your needs and 
does not make any representations regarding its use, quality, or the results that will be obtained. The 
software and images are provided "as is" and without warranty of any kind.



ZOOM
This option allows you to zoom in and out by selecting the numerical percentages listed on the options 
panel. Just select what percent to zoom and the application does it automatically.






